Stream Habitat Measurement Techniques
U.S. Fish and Wildlife Service, National Conservation Training Center

Water Body ldentification, Regional Setting, and
Drainage Catchment Attributes

This packet is your first assignment. We recommend that you save this
document as a .pdf to facilitate toggling between this file and the website links.

Please have this assignment completed before the webinar. We will go over the
answers during the webinar and answer any specific questions you may have.

In addition to in-stream habitat measurements, it is always important to
characterize the sampling site within its larger context. This characterization includes
water body identification (especially location), regional description (e.g., physiographic
province, ecoregion), and drainage catchment size and characteristics. We will make
use of three on-line mappers: the USGS “The National Map”, the EPA’s “WATERS
GeoViewer’ and the USGS “StreamStats”.

For this assignment, we will take you through the process to characterize a
sampling site using a specific stream location in Maryland. After you have become
familiar with the various tools, then you will do the characterization of the field site we
will be visiting during the week of class. It is very important that you finish this
assignment prior to the webinar as there will be no time to complete it after the class
has begun.

Water Body Identification

Detailed identification is important for:

» Organization of sample sites in data bases;

» |dentification by other data users; and

* Relocation on maps (e.g., GIS) or in the field.
Three forms of documentation:

» Descriptive attributes as name, stream classification (e.g., Rosgen), state
designated use, impairment status (Clean Water Act section 303(d)), ownership,
accessibility, etc.;

« Location coding with a unique number assignment (e.g., HUCs, EPA reach
codes); and

« Position identification (latitude, longitude, UTMs, elevation)
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Position identification (‘exact’ location) :

« Latitude, longitude, and Universal Transverse Mercator (UTM) coordinates define
the location of a point on earth in two-dimensional space (elevation can be used
as well to add the 3™ dimension)

« Latitude, longitude, UTM coordinates, and elevation can be obtained easily from
map viewers on the internet or USGS topographic maps.

» River mile or river kilometer still used, particularly on larger rivers, but less
common overall

Latitude and Longitude-

Latitude and Longitude Coordinate System

PRIME MERIDMAMN
o

EQUATOR O

15°
307

Red Dot: Galveston, Texas is 29°43°00” North & 94°48°00” West

Practical Exercise- (fill out the data form in Appendix 2 as you go through the
exercises, the answers are located in Appendix 4 at rear of this document):

We will now work with the location of the stream sample site. The site is on an
unnamed tributary of Little Antietam Creek.

The position is: Latitude 39.6611° N and Longitude -77.5464° W

These readings are in “decimal degrees” (the coordinates are expressed as decimal
fractions).
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v' Convert latitude and longitude in decimal degrees to degrees, minutes, and
seconds.

There are simple formulas to do this task, however it's even easier to use an internet-
based converter. Go to:

https://www.fcc.gov/media/radio/dms-decimal

Use the lower box to plug in latitude decimal degrees and then longitude decimal
degrees of the sample site to convert to degrees, minutes, and seconds. Enter only
numbers and the negative sign if appropriate, do not enter units (as degrees, minutes).

Record the Answer on your Data Sheet, Appendix 2

*Note that the converter also will convert degrees, minutes, and seconds into
decimal degrees.

v' Convert site position from latitude and longitude to Universal Transverse
Mercator (UTM) coordinates. See Appendix 1: Universal Transverse
Mercator Geographic Coordinate System for an overview of the UTM
coordinate system.

Go to UTM converter: http:/lIwww.dmap.co.uk/lI2tm.htm

Enter Degrees, Minutes, and Seconds for the stream site location (humbers only, no
units). Do not enter negative signs for lat/long coordinates west of Greenwich or south
of the equator. Specify W or S instead. Then choose grid area UTM (WGS84 datum)
and select “Calculate” for determining the central meridian longitude. Finally, click the
convert button to derive the Easting, Northing, and Grid Reference. The number(s)
preceding the letters of the Grid Reference is the UTM zone.

Your answer will be the coordinates for the sample site defined as:
Zone# Easting (m) Northing (m)

Record the Answer on your Data Sheet, Appendix 2

*Note: A good way to visualize lat-long and UTM is using Google Earth.
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If you have Google Earth downloaded on your computer:

Open Google Earth > click on “View” menu on upper left > select “grid” > click on
“Tools” > “Options” > select the “3D View” tab > select the “Decimal Degrees” radial
button in middle left of the box. Click “OK”. You'll see the latitude-longitude grid appear
on the globe. You can scroll in and out for a close-up or father-out perspective.

Now, to get the UTM grid, go back to “Tools” > “Options” > select the “Universal
Transverse Mercator” radial button. Click “OK”. You'll see the UTM grid appear, with
zone numbers laterally and zone alphabetical designations vertically.

If Google Earth is not installed on your computer
(and you are a FWS employee), you can access the
software through FWS Apps-to-Go without having to go
through your IT personnel.

Within FWS Apps-to-Go there are Google Earth-Pro
files you will need to access when downloading the
program. The “Google Earth Pro-On Demand” file will
download the program and the “Google Earth Pro-
Registration” file will access a PDF file with Online
Registration Information.
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Now, find the sample site on a map. Go to the USGS The National Map Advanced
Viewer at:

https://viewer.nationalmap.gov/advanced-viewer/

Screenshot of the National Map

The USGS Home
National onta
n Map ard

achanging world

Help DataDownload Services

If you want additional assistance, click on the “Help” link.

All tools you will be using are located under the “Widget Panel” at the top of the map.

Go to the icon set on the top left. Click on the button until you reach Zoom
Level 14. —— =

(The zoom level is noted in lower left)

Click on the Basemap Gallery icon E and select “USGS National Map”.

” oW LL 1

(Try other basemaps as “USA Topo Maps”, “Topographic”, “USGS Imagery Topo”).

In the “Find address or place” search box to the right of the Widget Panel, enter the
following latitude and longitude coordinates in decimal degrees (separated by a space
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and do not include the degree symbol or letter designations) for the unnamed tributary
of Little Antietam Creek. Click “

Latitude 39.6611° N and Longitude -77.5464° W

Note: Searching for the location may take a couple minutes. Let the wheel “spin”.
Eventually, you'll get a search result.

Search result 0 x

Point “A” is our
site. Click on

“Zoom To”

You can add a site marker by clicking on the three dots in the lower right of the Search
result box, then clicking on “Add a marker”. You can eliminate the box by clicking on the
“X” in the upper right corner. Or display the box by clicking on the location gray dot.

v" Find the sampling site elevation

To find the sampling site elevation, go to the icon . Note: This is the elevation
number you will use throughout the entire assignment.

Once you click on the Spot Elevation icon, a box will pop up on the rlght and you will
need to click on the “Activate” button. s

Click 'Activate' button and click on ti
retrieve elevation.

e |

When you do, the site marker might disappear so you’ll want to make a mental note of
the location or have added a marker prior. Click on the sample site location, and a “Spot
Elevation Results” box will appear with site elevation and location coordinates.
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v What is the county and state of the sampling location?

To find this information, open the Layer List icon @88 and activate “Government
Unit Boundaries” Show search resut =

Trensportation

Governmentsl Unit Boundaries

Record the Answer on your Data Sheet, Appendix 2

Find the USGS topographic map name that contains the sample site

In the Layer List pop-up box, deselect “Government Unit Boundaries”. Select the
“US Topo Availability” layer by checking the adjacent box. The topo name will be
in white text. If the screen is too opaque green, then go to the US Topo
Availability layer, click on the right-hand corner three dots, and select
“Transparency”; move the slider towards 100% transparency.

Record the Answer on your Data Sheet, Appendix 2

v" Find water body codes (HUC, reach codes)

Hydrologic Unit Codes (HUC)

The USGS organizes watersheds or drainage basins of the United States into a

hydrologic system that divides and subdivides the country into successively smaller
watersheds. These levels of subdivision, used for organization of hydrologic data, are
called "hydrologic units." Numerical codes, called "hydrologic unit codes (HUC)," are
associated with these units. The hydrologic unit codes describe the relation among the
hydrologic units to represent the way smaller watersheds drain areas that together form
larger watersheds.

Agencies use HUCs for:

managing natural resource data;

presenting stream survey and monitoring results;
storing and retrieving water quality data;
mapping land cover

Regions are the largest watersheds shown. Regions contain either the drainage

areas of a major river, such as the Missouri region, or the combined drainage areas of
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several rivers, such as the Texas-Gulf region. Regions are identified by 2 digit
codes.

Regions of the United States

Subregions divide the regions and they include the area drained by a river
system, a section of a river and its tributaries in that reach, a closed basin(s), or a
group of streams forming a coastal drainage area. Subregions are identified
by 4 digit codes.

Basins (or Accounting units) subdivide many of the subregions. They are used
by the USGS for managing national water data. Basins are identified by 6 digit
codes.

Subbasins (or Cataloging units) are larger than 700 square miles in area. A
subbasin is a geographic area representing part or all of a surface drainage
basin, a combination of drainage basins, or a distinct hydrologic feature.
Subbasins are sometimes called “watersheds” as in EPA’s Surf Your Watershed
(example: Conococheague-Opequon Watershed). Subbasins are identified by
8 digit codes.

Watersheds are identified by 10 digit codes.

Subwatersheds are identified by 12 digit codes.

Hydrologic unit codes are from 2 — 12 digits. A HUCS8 (subbasin or cataloging
unit) is 8 digits. For example, Nyes Run in the Susquehanna River drainage in

Pennsylvania is a part of the subwatershed identified by the code:

020503050905
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Region = 02

Subregion = 0205

Basin = 020503 (Accounting unit)

Subbasin = 02050305 (Cataloging unit, EPA watershed)
Watershed = 0205030509

Subwatershed = 020503050905

EPA Reach Codes

The National Hydrography Dataset (NHD) is a digital (computerized) collection of
points, lines and polygons that represent surface water features, such as streams, lakes
and swamps. Simply put, the NHD can be thought of as 'the blue lines on a map'. The
NHD addressing system employs a unique, standard identifier, known as the reach
code, for each segment of water across the country. Reach codes provide the
foundation or common 'language' supporting integrated surface water analysis between
EPA Water Programs, states, tribes and other users. Reach codes contain 14 digits.

A reach is the portion of a stream between two points of confluence. A
confluence is the location where two or more streams flow together. In the NHD
addressing system, a reach code identifies each reach in the same manner that a street
name identifies each street. Reach codes are comprised of the 8-digit EPA watershed
code followed a 6-digit arbitrarily-assigned sequence number.

Using the reach coding scheme, we can see that watershed 01080105 contains the five
reaches:

- 01080105000001
- 01080105000002
- 01080105000003
- 01080105000004
- 01080105000005

01080105

<) -Watershed - 01080105
e = MHD stream netwark
2 -Reach number - 000002
0  -cConfluence

Position along a reach is determined relative to the reach extent. The downstream end
of a reach is labeled as 0% and the upstream end as 100%. If a monitoring site, for
instance, lies halfway along a reach, its position is 50%.
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Start “National Hydrography (NHD) Dataset:

e Under the Layer List, deselect the “US_Topo_Availability” operational layer, and
select the “National Hydrography Dataset” operational layer.

First thing you'll notice is more complete stream delineation by blue flow lines and
stream names. Reaches are delineated by triangles. The triangles point in a
downstream direction. Scroll in and out to see more or less of the surrounding
landscape.

v" Determine the EPA Reach Code for the sample site (also stream name,
type, and length)

e Click somewhere on the reach containing the sampling site (reach ends denoted
by triangles); a search box will appear with NHD information (including stream
name [GNIS_Name], water body type, reach code, and length of reach). BTW,
there are vertical and horizontal scroll bars. The identified reach is colored lighter
green. (*It may be frustrating to get the search results boxes to appear with a
click, but keep trying. Eventually, this will work).

Record the Reach Code & Reach Length on your Data Sheet, Appendix 2

e Click on tributaries or other streams to see additional reaches and reach codes:; if
the reach is named, the GNIS_Name will be populated.

Start “Watershed Boundary Dataset”:

¢ In the Layer List box, deselect “National Hydrography Dataset” and click the box
next to “Watershed Boundary Dataset”.

HUC codes should appear. Scroll out to Level 4 (or click onn) and then scroll in to
view the complete range of nested HUCs for the sampling site, from HUC-2 (Region) to
HUC-12 (Subwatershed). Give the Map time to populate with information, it probably will
take a few seconds. Note: For this Subregion, there is only one Basin, therefore the
Subregion and Basin are the same geographic area.

v' Determine the HUC-12 subwatershed area for the sample site

Practice determining areas by tracing the boundary of the Subwatershed HUC unit with
the area tool under the Measurement icon. Click on the Measurement icon and
select the area tool in the pop-up box. ’

e Enlarge the Subwatershed HUC unit on your screen (make sure the no part of
the HUC-12 is covered by the pop-up box. Using the area tool, follow the
Subwatershed boundaries. To change direction, click once; to finish, click twice.
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Once you double-click, the area measured is filled in and area measurements
appear in the pop-up box.

Record the Answer in the chart provided on your Data Sheet, Appendix 2

v' List HUCs and their names and areas:
Another way to locate the name of each HUC2 — HUCS in the Region, go to:

http://water.usgs.gov/GIS/regions.html

(Hint: the site is in HUC 02 Mid-Atlantic Region)
Note: areas are only listed for HUC4, HUCG6, and HUCS.

e Determine area of the Subregion HUC 0207

Record the Answers in the chart provided on your Data Sheet, Appendix 2

Google Earth can be a good communication tool to share sample site location data. For
example, open Google Earth and enter the lat-long coordinates for our sample site
(39.6611 -77.5464) in the search box upper left. You should get something like this:

Ehe R yww ook AN ek

To | FdBusnessss | Ciections
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oogle Earth - New Placemark X

Latitude: | 39.661100°

Longitude: |-77.546300°

Description | Style, Colar | view

Altitude

| addlink... | [Addimage...

OF

H Cancel ]

= Google Farth

1\ +

Click on the “Add Placemark” | * |. A “New
Placemark” box and a yellow location placemark
on the map will appear. In the box, the
coordinates will be automatically filled. If, under
Tools>Options, the Decimal Degrees radial
button is selected, then the coordinates listed will
be Latitude and Longitude. However, if the
Universal Transverse Mercator radial button is
selected, coordinates will be in UTMs. Next, type
in “Warner Hollow branch sample site 1” in the
Name box. You can enter a description as “Just
upstream of Edgemont Reservoir” in the
Description tab. Click “OK”.

Placemark indicating the sampling site.
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To save the location on your hard drive, in the upper left corner, click on
File>Save>Save Place As...

A “Save As” box will appear. You can change the name of the file. The extension is
“.kmz”. This file can be double-clicked which will open Google Earth and take the view

to the sampling site. This .kmz file can be emailed for others to view your sampling
location.

v' Determine “Impairment Status”

We will leave The National Map Viewer and use another Viewer entitled WATERS
GeoViewer, an EPA application. Go to:

https://epa.maps.arcgis.com/apps/webappviewer/index.html?id=ada349b90c26496ea52aab66a092593b

e Enter the following sampling site latitude and longitude coordinates (numbers
and negative sign only) into the “Find surfacewater or place” bar on left. Click on
the search icon.

Latitude 39.6611° N and Longitude -77.5464° W

e Sample site should be centered in view and show as a gray dot.
e On the right, click and change Basemap to “USGS National Map”.
e On the left, click on the arrow next to “Feature Layers”.

Layers Q=

g Feature Layers

e Check box next to “EPA Linked Data”

Layers Q=
Fosturs Layers
 _’ EPA Linked Desa
Click on the arrow next to “EPA Linked Data”
Now, check box next to “303(d) Listed Impaired Waters”
Scroll out slightly. Is the stream containing the site a 303(d) impaired water?

Scroll out further, eventually you will see streams outlined in red |nd|cat|ng
impaired reaches.

By clicking on the arrow by “303(d)
Line”, you'll eventually see the color
and shape legend.

E(i mont
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e Deselect “303(d) Listed Impaired Waters” and check the box next to “TMDLs on
Impaired Waters”

e Scroll in and out to see where TMDLs are located in the area.

=
7

7
Waynesboro . />

Wayne Heights

e Optionally, you can continue this investigation by checking “Fish Consumption
Advisories”, or “Fish Tissue Data” or “Facilities that Discharge to Water”.

e Back to our sample site on an un-named tributary of Little Antietam Creek, is this
reach designated as “impaired water”?

Record any impairments for the sample site on your Data Sheet, Appendix 2

v" Access Water Quality Data

e STORET (STOrage and RETrieval) is a water quality dataset. To locate
STORET Water Monitoring stations near the sampling site, under the expanded
“‘EPA Linked Data”, click on the “Water Monitoring” box. Station locations will
appear as a green triangles. Go to the second upstream triangle from the
sample site and click on the triangle. These actions will bring up information
about that station, including a Watershed Report (watershed landuse/cover) and
a link to STORET data downloads. Click on the Watershed Report, a new
website will appear. View the results.

e Close the “Watershed Report” tab.

EPA Linked Data:
Watar Monitoring

e For water quality data links, click on “More about this Linked Data Feature”.

e A new webpage will appear; click on the “Portal Page” link.

e Enter “MDE_FIELDSERVICES_WQX-ULAO0009” into the “Site ID” box and then
click on the white text in the blue box that appears.
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e Scroll down to the bottom of the page, select “Sample results (physical/chemical
metadata”, and then click on the DOWNLOAD button (see figure next page).

Select data to download:
Organization Data

Site data only

Project data

Project Monitoring Location Weighting data
* Sample results (physicalichemical metadata)

Sample results (biological metadata)

Sample results (narrow)

Sampling Activity

Sampling Activity Metrics

Result Detection Quantitation Limit Data

Biological Habitat Metrics

DOWNLOAD

e Click “Continue” on the popup box and save it in your Downloads folder for
example.

¢ Open the zip folder and open the .csv results file in Excel.

e You can view water quality data for that station in the AF — Al column range.

v' Locate USGS Stream Gages

e Deselect “EPA Linked Data” and select “Other Linked Data”.
e Select USGS Streamgages.
e Scroll out to see locations of the gaging stations (symbol = green circles).

v' Delineate Catchment or Drainage Basin Boundaries

o We will address this in more detail later; however, the WATERS GeoViewer
delineates catchment boundaries that can be modified to measure drainage area.

e Put the sample site (above Edgemont Reservoir) in view.

e Make sure “Surface Water Features” is checked; expand this layer by clicking on
the arrow next to the checked box.

e “Streams” should be selected; also check the box next to “Catchments”

e You should get this- N e /
the drainage basins ;
are outlined in orange.
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e To measure drainage basin area, use the Measurement Tool

o Measurement
=%

i | &= & | SqMiles +

Measurement Result

e You can either trace the catchment boundaries (will be very close to that area
draining into the sampling site, or you can start and end at the sampling site
itself.

v View HUCs and their information:

e Still under the “Surface Water Features” layer, deselect “Catchments” and check
the box next to “Hydrologic Units”.

e As you scroll in and out, the HUC unit will change between Region to
Subwatershed.

¢ Click on a hydrologic unit, the HUC boundary will change color and a
Surfacewater Feature box will appear with the HUC code, name, and area.

i3] Hydrologic Units
]

Dascription
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Regional Setting

Regional setting influences the physical structure (geomorphology) and biological
structure of a stream reach. As such, regional setting attributes can be used to stratify
streams into categories for sampling design or analysis.

e Regions represent broad patterns of climate and geology and influence many
properties of aquatic habitats (hydrology, substrates, morphology, etc.).

e Aregion is recognized as having aquatic habitats that are more similar to each
other than they are to habitats in other regions.

e When working with large spatial scales, recognizing groupings of similar habitats
helps a biologist establish benchmarks for habitat potential and lowers variability
in data.

Regional classification systems often are hierarchical.

e Regional management must consider multiple spatial scales to accommodate
aquatic systems.

e Series of levels organized so that finer classified regions nest within the next
larger class.

e These classification systems provide a stratification framework that can reduce
data variability thereby improving power of projects to detect trends or
differences.

Example of a hierarchical structure in spatial frameworks (Bailey’s Ecoregion System)

DOMAIMNS

PROVINCES
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Regional Settings include such classification systems as

e Physiographic provinces
e Hydrogeomorphic regions
e Ecoregions

Physiographic Provinces

Based on: TOPOGRAPHY (mountains, plains, plateaus, uplands) and GEOLOGY

(rock type and geologic structure and history)
Hierarchical, 8 major divisions, 25 natural subdivisions (provinces)

Differ in climate, vegetation, surficial deposits and soils, water supply,
mineral resources

« Boundaries between provinces are often sharp

» Used to identify fish distributions

An Example of Physiographic Provinces Contained Within a State

Blue
Ridge
Province

Appalachian
Plateaus
Province

Ridge and Valley

Province Piedmont Plateau Province

Western Shore

Folded Appalachian
Lowlands

Mountains Section
Region
Delmarva
Physiographic Provinces Peninsula
. Region
and Their
Subdivisions in Maryland Atlantic
Continental
P ——— Shelf
0 miles 50 Province

Province Boundary
Subdivision Boundary

Maryland Geological Survey
January, 2001

http:ffwww.mgs.md.gov

Coastal Plain Province
Embayed Section

18 USFWS-NCTC



Stream Habitat Measurement Techniques
U.S. Fish and Wildlife Service, National Conservation Training Center

The Physiographic Province system may be subdivided into successively smaller units:
Major Division > Province > Section > Region > District > Area

(Note: different terminology is sometimes used; e.g., “subprovince” used for “Section”)

For example, a stream site in Maryland might be classified as within the

Applalachian Highlands Division
Blue Ridge Province
Northern Blue Ridge Section
Middletown Valley Region
Lower Middletown Valley District
Catoctin Creek Gorge Area

Practical Exercises: for the following exercises please refer to the resource maps
located at:

http://nctc.fws.qgov/courses/csp/csp3200/resources/index.html

v" Find the physiographic province, section, and region of the sample site on
the un-named tributary of Little Antietam Creek. Use the Physiographic
Map of Maryland (note that the sample site location is indicated by an
arrow). You may save as a .pdf for better viewing or just use the zoom
function at the bottom right corner.

Record the Answer on your Data Sheet, Appendix 2

*Note: For a narrative description of the physiographic province characteristics, see
James P. Reger, J.P. and ET. Cleaves. 2008. An Expanatory Text for the
Physiographic Map of Maryland. Open-File Report 08-03-01 Map of Maryland
Description. You'll see an overview of the physiographic region classification
system starting on page one and a brief description of the Blue Ridge Province
on page 5.

Hydrogeomorphic Regions

e Used for stratifying ground-water discharge patterns and wetland functions
e Based on lithology (rock type) and physiography based on geologic formations
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Open Hydrogeomorphic Regions which maps the hydrogeomorphic regions of the
Chesapeake Bay watershed.

v" What hydrogeomorphic region is the sample site located in?
Record the Answer on your Data Sheet, Appendix 2
Ecoregions

Relatively uniform areas defined by several key geographic variables (physical and
biotic)

e such as, geology, landform, soils, vegetation, climate, wildlife, land use
e hierarchical classifications (broad scale to fine scale)

Ecoregions are used to:

e identify the natural characteristics and potential of aquatic systems;

¢ determine regional boundaries to set benchmark biotic potential and to measure
and evaluate aquatic system integrity against the appropriate benchmark;

e establish water quality standards;

e stratify sampling sites;

e extrapolate to regional information from site-specific studies

2 commonly used classification systems:

Bailey’s (provides a broad synthesis of ecosystem geography of the US)

Omernik’s (provides a classification for regionalizing water resource management
and for distinguishing regional patterns of WQ in ecosystems as a result of
land use)

For this class, we will use Omernik’s Ecoregion classification system.

e A classification for regionalizing water resource management
e Used to distinguish regional patterns of water quality due to land uses
e Found to correspond well to spatial patterns of water quality and fish distribution

Hierarchical:

Level | (15 ecoregions in North America)

Level Il (50)

Level Il (182; descriptions include landforms, potential vegetation, land use,soils)
Level IV (NA coverage not comprehensive)
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v List Omernik Ecoregion levels I, Il, lll, and IV for the sample site

o For all Ecoregion levels, select the appropriate link on the course page
under the Resource Maps section. View the pdf or download the maps

http://nctc.fws.qov/courses/csp/csp3200/resources/index.html

Note: You can zoom in and out using the maps. For more exact assignment of the
sampling site to Level lll and IV Ecoregions, go to:

https://geodata.epa.gov/ArcGIS/rest/services/ ORD/USEPA Ecoregions Level Il and [V/MapServer/

e Click on “ArcGIS Online map viewer”.

JSOMN | SOAP | WMS

ORD/USEPA_Ecoregions_Level_III_and_IV (MapServe

View In: ArcGIS JavaScript ArcGIS Online map viewer Google Earth ArcMa

View Footprint In: ArcGIS Online map viewer

¢ Move screen until you locate the sample site.
e The Ecoregion overlay probably will be too opaque to see where the sample site

is located; so, adjust the transparency by clicking on the 3 dots under the USEPA
Ecoregions Level lll and IV.

[E)Dstails | BB Basemap

Conten: i= Legend

You may need to move the screen to see the number/letter Ecoregion designation.

You can download layers for a GIS or a .kmz file for use in Google Earth. Under “View
In:”, select your platform, such as Google Earth. Then open Google Earth. The
Omernik levels will be in the “Places” window on the right. To view the satellite image,
de-check the box next to ORD/USEPA_Ecoregions_Lev..., to view the Ecoregion
designations, check the box.

Record the Answers on your Data Sheet, Appendix 2.
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See also the description of the Level lll Ecoregions for the continental U.S. in:
Eco Level lll Descriptions
For both Level Il and Level IV Ecoregion descriptions for the sample site, see

EPA Region 3 Eco Description

Catchment Basin Characteristics

A sample site’s catchment is all the stream
segments upstream of the sample site and all
of the land that drains into those streams.
The topographic watershed boundary runs
along ridges (“divides”).

From Rivers of Alabama

Catchments are nested: here’s an example with sample sites denoted as red circles,
and catchment areas as dashed lines-

Important catchment attributes,
« Size (e.g., acres, hectares, square miles)

« Geomorphic properties (e.g., basin length and relief, drainage density and shape)
» Stream size of reaches (e.g., stream order)

« Land cover (e.g., geology, soils, vegetation, and land use in area & proportions)

Catchment basin attributes influence hydrology (water yield and pattern of floods) and
sediment yields; both factors influence stream morphology and in-stream habitat.
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Catchment basin size
Importance of catchment basin size include:

e A factor behind geomorphological attributes as bankfull discharge, mean
depth, width, and cross-sectional area (i.e., stream size and shape).

e Drainage basin size often used to match study sites; for example, comparing
similar-sized impaired sites to reference sites

e Assume similar sized stream sites have similar potential (e.g., fish species
richness), other factors being equal

Catchment basin size can be determined by

e U.S. Geological Survey topographic maps (e.g., scale of 1:24,000 or 1
distance unit on map equals 24,000 distance units on ground)

e or more commonly, Geographic Information Systems (GIS) or map viewers

Some basics,
Topographic map features:

e blue lines = streams
— solid lines = perennial streams
— dashed lines = intermittent streams
e brown lines = contour lines
— form “V’s where they intersect streams (“M”s above stream junctions);
“V”s point upstream
— topographic high points marked by ring
e Headwater streams = streams with no tributaries

Note: It is important to realize that blue lines may not be an accurate representation of
the spatial extent of perennial or intermittent streams. Aquatic macroinvertebrate taxa
that require perennial water have often been found “above the blue line” in Appalachia.
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USGS Topographic Map
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Determining a topographic catchment basin

e |ocate all upstream tributaries that contribute flow through study site
¢ |ocate headwaters to determine top of drainage basin

e determine approximate location where surface run-off splits flow into and away
from basin

e connect topographic high points
e draw drainage divide perpendicular to each contour line it crosses

e on flat areas, divide in half the area between streams
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Example of a catchment basin for a sampling site on Virgil Creek

v" Determine the catchment basin size in square miles for the sample site on
the un-named tributary of Little Antietam Creek.

Open the USGS StreamStats:

https://streamstats.usgs.gov/ss/

¢ Click on Base Maps bar on the right and select “National Map” for topographic
interface

e Enter the sample site location coordinates: Latitude 39.6611° N and Longitude
-77.5463° W in the searchbox on the left. Do not input the degrees unit or letters.
Click on the coordinates in the results box.

e Select “Maryland and District of Columbia” study area (blue bar far left).

e The study site should be denoted and the NHD “blue lines” active; you may have
to scroll out or in.
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e Click on the blue “Delineate” button. Now, click on a blue pixel at the sampling
site; you may need to scroll in; the delineation will take a few seconds.

e The drainage basin for the study site should be highlighted in yellow. Click
“Continue”.

e Click the “Peak-Flow Statistics” button (it will turn blue)
e Click on the down arrow by “Basin Characteristics”

Basin Delineated

T

Step 2: click "Continue® to proceed.

e Select DRNAREA, FOREST_MD

e Click “Continue”

e After computation, click “Show Basin Characteristics”; you will see calculated
values for the parameters you selected. For the data sheet, only drainage area
and % FOREST will be recorded.

e Click “Continue” for the Basin Characteristics Report.

¢ Note that some locations have the additional capacity to calculate low-flow
statistics for the selected site.

Record your answer on your Data Sheet, Appendix 2
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v" Plug your catchment size (in square miles) into the regional curves listed
below. Either estimate from the graph or enter the sampling site catchment
area into variable “DA” of the prediction equations. Determine expected
bankful discharge, cross-sectional area, width, and mean depth for the

sample site.
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Record your answers on your Data Sheet, Appendix 2
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Steam size

Stream size can be characterized in several ways, including by catchment size,
average stream width, or by stream order (Strahler, Link Magnitude, D-Link, C-Link, and
B-Link). Stream size is important for determining biotic potential of streams. Larger
streams support more species of fish, for example.

Position of streams in the larger watershed can be described by the link system.
Position also can be an important determiner of species richness.

Stream order:
The oldest and most commonly used is Strahler stream order (Strahler 1957).
e headwater streams = 1st order

e 2 streams of order n form a stream of order n + 1

e 2 streams of different orders -- the stream they form does not change
order (below confluence, stream order is the higher of the two parent
streams)
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Stream Order: Link Magnitude (Shreve 1966)

e Link magnitude is the number of un-branched source streams
upstream of a given segment in the drainage network.

e Think of it as a “finer-grained” stream size metric than stream order
(used more in benthic invertebrate work

e The
Link

-
3

Magnitude number of a reach indicates how many tributaries are
upstream of the reach.

Stream Order: D-Link

e Osborne and Wiley defined D-link as the link magnitude of the next
downstream segment from the segment in question.

e Emphasizes differences of small streams in upper watershed vs.
small streams directing joining much larger streams. Reason:
similar sized streams could have different fish faunas depending
upon where they link up to the stream system.

e “Adventitious streams” are small streams that join much larger
streams (have small link number and large D-link number)

e First determine Link Magnitude for a drainage. Then “shift up” the
rating from the lower to the adjacent upper reaches (= D-Link).
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For example,

Undefined

D-Link

Link Magnitude

Now, use more complicated drainage examples of Link magnitude and D-Link to
illustrate D-Link application.

Link Magnitude D-Link

4%:1

14 15

v" Print out the catchment for the sample site in the USGS map viewer or
make hand sketches of the drainage. Determine Strahler stream order,
Link Magnitude, and D-Link for each stream reach. What is the Strahler
stream order, Link Magnitude, and D-Link values for the reach at the

sample site?
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Geomorphic Properties

Several geomorphic properties of catchments are listed and explained in Appendix 3
Geomorphic Properties Exercises. These basin characteristics can be determined
using the USGS The National Map and the basin drainage area you calculated in
StreamStats. We will not calculate these properties in this class, but provide answers at
the end of this document.

kkkkkkkkkkkkkkkkkkkkkkkkhkkhkhkkkkhkkkkkkkkkkkkkhkkkkkkkkhkkkkhkkkhhkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkk

Now that you have completed the example exercise for the unnamed tributary of
Little Antietam Creek, go through the same process to characterize our class field
trip site (note: the sampling site is in Virginia). Complete Appendix 2 Sample Site
Identification, Regional Setting, Catchment and Reach Size Data Sheet and
Appendix 3: Geomorphic Properties Exercises for the Sweet Run site. An aerial
photo and topo map for “Sweet Run” and a Physiographic Map of Virginia are
located at:

http://nctc.fws.qov/courses/csp/csp3200/resources/index.html

Note: the field trip sites are designated as “degraded reaches” on the photo and topo.
This designation was for another class, although our sites are located within the
rectangle.

The Field Site Location (Sweet Run) coordinates are:

Latitude 39.280278° N, Longitude -77.742550° W

Answers will be discussed during the webinar. We will be using this information as part
of our analysis of the sampling site.
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Appendix 1: Universal Transverse Mercator Geographic Coordinate System

The Universal Transverse Mercator (UTM) geographic coordinate system is a grid-
based method of specifying locations on the surface of the Earth that is a practical
application of a 2-dimensional Cartesian coordinate system. It is a horizontal position
representation, i.e., it is used to identify locations on the earth independently of vertical
position, but differs from the traditional method of latitude and longitude in several
respects.

The UTM system divides the surface of Earth between 80°S and 84°N latitude into 60
zones, each 6° of longitude in width and centered over a meridian of longitude. Zone 1
is bounded by longitude 180° to 174° W and is centered on the 177th West meridian.
Zone numbering increases in an easterly direction.

UTM Zones in the Northern and Western Hemisphere
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Each of the 60 longitude zones in the UTM system is based on a transverse Mercator
projection, which is capable of mapping a region of large north-south extent with a low
amount of distortion.

An Earth location is defined as a point with x and y coordinates. In the UTM system, the
terms easting and northing are geographic Cartesian coordinates for a point. A position
is referenced by the UTM zone, and the easting and northing coordinate pair. The
easting is the projected distance of the position eastward from the central meridian,
while the northing is the projected distance of the point north from the equator (in the
northern hemisphere). Eastings and northings are measured in meters. The point of
origin of each UTM zone is the intersection of the equator and the zone's central
meridian. In order to avoid dealing with negative numbers, the central meridian of each
zone is given a "false easting" value of 500,000 meters. Thus, anything west of the
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central meridian will have an easting less than 500,000 meters. For example, UTM
eastings range from 167,000 meters to 833,000 meters at the equator (these ranges
narrow towards the poles). In the northern hemisphere, positions are measured
northward from the equator, which has an initial "northing" value of 0 meters and a
maximum "northing" value of approximately 9,328,000 meters at the 84th parallel — the
maximum northern extent of the UTM zones. In the southern hemisphere, northings
decrease as you go southward from the equator, which is given a "false northing" of
10,000,000 meters so that no point within the zone has a negative northing value.

As an example, the CN Tower is located at the geographic position 43°38'33.24"N,
79°23'13.7"W or 43.6425667°N, 79.387139°W or 43.6425667, -79.387139. This is in
zone 17, and the grid position is 630084m east, 4833438m north. There are two points
on the earth with these coordinates, one in the northern hemisphere and one in the
southern. To define the position uniquely:

e Append a letter designator to the zone number, in this case "T" (see previous
figure), thus "17T 630084 4833438".

Exercise-

Go to UTM converter http://www.dmap.co.uk/ll2tm.htm

Enter Degrees, Minutes, and Seconds for the stream site location. Then choose grid
area UTM (WGS84 datum) and the calculate button for determining the central meridian
longitude. Finally, click convert to finish calculation.

Your answer will be in easting and northing (x,y) coordinates (281507, 4393344); the
grid reference is 18STJ 81507 93344. The first number of the grid reference number is
the UTM zone. You would report your location as 18S 281507m E 4393344m N.

Notice that the central meridian of zone 18 is 75° W longitude, because the eastern
boundary is 72°W and the western boundary is 78° W.

UTM Zones in the Continental United States

126°W 120°W 114°W 108°W 102°W 96°W 90°W B4*W T78°W 72°W 66°W

Red star denotes approximate
location of stream sampling site.
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Appendix 2: Sample Site Identification, Regional Setting,
Catchment and Reach Size Data Sheet

Investigator: Date:

Position Identification

Stream name/Study site name:

Latitude Longitude Elevation

Grid Reference

Zone UTM

County State

USGS Topographic Map Name

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

Division HUC Name Area
Region
Subregion
Basin
Subbasin
Watershed E
Subwatershed

USEPA reach code Reach Length

Water Impairments:

Regional Setting

Physiographic Province code/name:
Section code/name (or subprovince):
Region code/name:
District code/name: N/A
Area code/name: N/A
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Hydrogeomorphic region:

Ecoregions:

Omernik Level |

Omernik Level Il

Omernik Level Il

Omernik Level IV

Catchment (“Drainage”) Basin Characteristics

Catchment area

Percent Forest

Bankfull discharge

Cross-sectional area

Width

Mean depth

*Reach type (e.g., Rosgen classification)

Reach size:

*Average bankfull width

Strahler Stream Order

Link Magnitude

D-Link

* Stream classification and average bankfull width will be determined after field data
collection.
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Appendix 3: Geomorphic Properties Exercises

Once the catchment divide is drawn on a map and the area has been estimated (via
StreamStats), the geomorphic properties can be estimated, measured, or computed in
The National Map. Each of the geomorphic properties listed below includes a definition
and explanation of its importance to catchment characterization. The downstream
boundary of the catchment is the sample site.

In The National Map, locate the study site. In the Layer List, check the “National
Hydrography Dataset” and the “Watershed Boundary Dataset”. Remember, you can get
reach lengths using the NHD information. You can determine drainage area in The
National Map or in StreamStats.

1. Main channel slope: Main channel slope is an estimate of the typical rate of
elevation change along the main channel that drains the catchment. This
measurement is often related to peak flow magnitude and flood volume. Estimate
the main channel slope by measuring the length of the main channel from the
study site to the mapped source of the main stream. At each stream channel
bifurcation, follow the fork with either the higher stream order number or the
longer pathway to a stream source. Mark off 10% and 85% of the main channel
length on the map. Estimate the elevation in meters at the 10% and 85%
distance points, using the contour lines on the topographic map. Compute the
main channel slope as follows:

Slope = (elevation at 85% length — elevation at 10% length) / 0.75 (main channel
length).

Use: Elevation profile tool

ANSWER:

2. Total stream length: Total stream length is the sum of the lengths of all
perennial streams within a catchment as shown on a topographic map.
Determine the total stream length by using NHD information. Sum individual
stream lengths. The summed stream lengths determine the total amount of
stream habitat in a catchment and the availability of sediment for transport.

ANSWER:
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3. Catchment length: Catchment length is estimated as the straight-line distance
between the stream site and the drainage divide nearest to the source of the
main stream [see “Main Channel Slope” description to find out how to delineate
the main stream}. Catchment length is used to calculate drainage shape.

Use: Distance tool in Measurement icon.

ANSWER:

4. Catchment relief: Catchment relief is the difference in elevation between the
highest and lowest points in the catchment. It controls the stream gradient and
therefore influences flood patterns and the amount of sediment that can be
transported. Sediment load increases exponentially with catchment relief.

Use: Spot Elevation tool

ANSWER:

5. Catchment relief ratio: The catchment relief ratio index is the catchment relief
divided by the catchment length. It is useful when comparing catchments of
different sizes because it standardizes the change in elevation over distance.

ANSWER:

6. Catchment surface storage: The percentage of the catchment covered in lentic
and impounded water bodies, including wetlands (optional), reflects the surface
storage capacity of the catchment. Determine the catchment surface storage by
measuring the area of each lake or impounded water body. Wetland areas will
have to be estimated because the borders are not delineated on topographic
maps. Add all water body and wetland areas and divide this sum by the drainage
area.

Make a visual estimate or use StreamStats to calculate impoundment percent.

ANSWER:
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7. Drainage density: An index of the length of stream per unit area of catchment is
calculated by dividing the total stream length by the drainage area [see #8]. This
ratio represents the amount of stream necessary to drain the catchment. High
drainage density may indicate high water yield and sediment transport, high flood
peaks, steep hills, low suitability for agriculture, and high difficulty of access.

ANSWER:

8. Drainage shape: An index of drainage shape is computed as a unit-less
dimension of drainage area divided by the square of catchment length. It
describes the elongation of the catchment and is useful for comparing
catchments. If two catchments have the same area, the more elongated one will
tend to have smaller flood peaks but longer lasting flood.

ANSWER:
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Appendix 4: Answers to Questions

Sample Site Identification, Regional Setting, Catchment and
Reach Size Data Sheet

Position Identification

Stream name/Study site name:__unnamed tributary of Little Antietam Creek

Latitude _ 39° 39' 39.9594" N Longitude _-77° 32'47.04" W Elevation __937

Grid Reference 18STJ 8155693243

Zone 18S UTM 18 281556m E 4393243m N
County _ Washington State Maryland
USGS Topographic Map Name Smithsburg

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

Division HUC Name Area
Region 02 Mid-Atlantic N/A
Subregion 0207 Potomac 14,600 mi?
Basin 020700 Potomac 14,600 mi?
Subbasin 02070004 Conococheague - Opequon | 2,278.9 mi?
Watershed 0207000410 Antietam Creek 290.9 mi?
Subwatershed | 020700041004 | Little Antietam Creek 24.7 mi?

USEPA reach code 02070004002574 Reach Length 1.18 km

Water Impairments None

Regional Setting

Physiographic Province code/name:
Section code/name (or subprovince):
Region code/name:
District code/name:

Area code/name:

300000 Blue Ridge Province

310000 Northern Blue Ridge Section

312000 Catoctin-South Mountain Region

N/A

N/A

39
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Hydrogeomorphic region: Blue Ridge
Ecoregions:
Omernik Level | Eastern Temperate Forests (8)
Omernik Level Il ___Ozark, Ouachita-Appalachian Forests (8.4)

Omernik Level Il Blue Ridge (66)

Omernik Level IV Northern Sedimentary and Metasedimentary Ridges (66b)

Catchment Basin Characteristics

Catchment area 2.27 square miles or 5.88 square kilometers

Percent Forest 90.6 %

Bankfull discharge 73 cfs
Cross-sectional area 24 ft2
Width 20 ft
Mean depth 1.2 ft

*Reach type (e.g., Rosgen classification)

Reach size:

*Average bankfull width

Strahler Stream Order 2

Link Magnitude 6

D-Link "Undefined”

* Stream classification and average bankfull width will be determined after field data
collection.

40 USFWS-NCTC



Stream Habitat Measurement Techniques
U.S. Fish and Wildlife Service, National Conservation Training Center

Geomorphic Properties Exercises (answers)

Once the catchment divide is drawn on a map and the area has been estimated (via
StreamStats), the geomorphic properties can be estimated, measured, or computed in
The National Map. Each of the geomorphic properties listed below includes a definition
and explanation of its importance to catchment characterization. The downstream
boundary of the catchment is the sample site.

In The National Map, locate the study site. In the Layer List, check the “National
Hydrography Dataset” and the “Watershed Boundary Dataset”. Remember, you can get
reach lengths using the NHD information. You can determine drainage area in The
National Map or in StreamStats.

1. Main channel slope: Main channel slope is an estimate of the typical rate of
elevation change along the main channel that drains the catchment. This
measurement is often related to peak flow magnitude and flood volume. Estimate
the main channel slope by measuring the length of the main channel from the
study site to the mapped source of the main stream. At each stream channel
bifurcation, follow the fork with either the higher stream order number or the
longer pathway to a stream source. Mark off 10% and 85% of the main channel
length (feet or meters) on the map. Estimate the elevation in feet or meters at the
10% and 85% distance points, using the spot elevation tool or the contour lines
on the topographic map. Compute the main channel slope as follows:

Slope = (elevation at 85% length — elevation at 10% length) / 0.75 (main channel
length).

Use: Elevation profile tool

ANSWER: 442m — 286m / 0.75(3828.6m) = 0.54, 5.4%

2. Total stream length: Total stream length is the sum of the lengths of all
perennial streams within a catchment as shown on a topographic map.
Determine the total stream length by using NHD information. Sum individual
stream lengths. The summed stream lengths determine the total amount of
stream habitat in a catchment and the availability of sediment for transport.

ANSWER: 4.522 mi or 7.2775km
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3. Catchment length: Catchment length is estimated as the straight-line distance
between the stream site and the drainage divide nearest to the source of the
main stream [see “Main Channel Slope” description to find out how to delineate
the main stream}. Catchment length is used to calculate drainage shape.

Use: Distance tool in Measurement icon.

ANSWER: 3.548 kilometers - 11,641.448 feet - 2.205 miles

4. Catchment relief: Catchment relief is the difference in elevation between the
highest and lowest points in the catchment. It controls the stream gradient and
therefore influences flood patterns and the amount of sediment that can be
transported. Sediment load increases exponentially with catchment relief.

Use: Spot Elevation tool

ANSWER: 936’ - 1826’ = 890’

5. Catchment relief ratio: The catchment relief ratio index is the catchment relief
divided by the catchment length. It is useful when comparing catchments of
different sizes because it standardizes the change in elevation over distance.

ANSWER: 890" /11,641 = 0.08

6. Catchment surface storage: The percentage of the catchment covered in lentic
and impounded water bodies, including wetlands (optional), reflects the surface
storage capacity of the catchment. Determine the catchment surface storage by
measuring the area of each lake or impounded water body. Wetland areas will
have to be estimated because the borders are not delineated on topographic
maps. Add all water body and wetland areas and divide this sum by the drainage
area then multiply by 100.

Make a visual estimate or use StreamStats to calculate impoundment percent.

ANSWER: (.016 mi2 / 2.4mi%) x 100 = 0.67%
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7. Drainage density: An index of the length of stream per unit area of catchment is
calculated by dividing the total stream length by the drainage area. Drainage
density is usually expressed in terms of stream miles per square mile. This ratio
represents the amount of stream necessary to drain the catchment. High
drainage density may indicate high water yield and sediment transport, high flood
peaks, steep hills, low suitability for agriculture, and high difficulty of access.

ANSWER: 4.522 miles/ 2.4 mi? = 1.89 mi/ mi?

8. Drainage shape: An index of drainage shape is computed as a unit-less
dimension of drainage area divided by the square of catchment length. It
describes the elongation of the catchment and is useful for comparing
catchments. A more elongated watershed will have a lower value. If two
catchments have the same area, the more elongated one will tend to have
smaller flood peaks but longer lasting flood.

ANSWER: 2.4 mi?/ (2.205)> = 0.49
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